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Introduction

Overview

Welcome! This software tool will help your cardiac and/or pulmonary rehabilitation program collect and
analyze outcome data. The main goal of this software is to provide a standard set of measurement and
analysis tools that all rehabilitation programs can easily use. It is only through the standardization of
collection methods that programs will be able to compare outcomes.

With this tool, you have the ability to measure over many outcomes in five domains:
Behavioral Outcomes

Clinical Outcomes

Economic Outcomes

Health Outcomes

Senice Outcomes

Data points in each of these areas can be collected and analyzed using this software. Although, you
are not required to use all of the data points provided, it is highly encouraged to collect as many as
possible. This will provide the most beneficial information on how your program is improving the overall
health of its patients.

Features

¢ Able to collect over 75 different outcome data points

¢ Able to breakout patients by diagnosis, insurance provider, referring physician, sex, and more
¢ Analyzes data using mean, % change, level of significance and more

e Generates individual patient performance reports

e Generates a variety of program summary, demographic, and continuous quality improvement
reports

¢ Creates data graphs for visualizing change

e Tracks and helps to schedule evaluation visits

¢ Able to export data via diskette or the Internet for benchmarking
e Multi-user and network capabilities

Why Collect Outcome Data?

Collecting outcome data on your program is not an option anymore. It is required for JCAHO
accreditation and for AACVPR program certification. Collecting and analyzing the outcome data from
your program is also an important part of continuous quality improvement. However, only benchmarking
among your peers will help to document the true effectiveness of your program.

The key to facilitating this comparison between programs is the standardization of the outcome data
collection and analysis methods used. If you are collecting outcome data without standardization, then
you have no frame of reference for how your program is performing compared to the programs of your
peers. This software will help you to begin to collect a standardized set of outcomes

Collecting and analyzing information on the benefits your patients’ experience from participating in your
rehabilitation program is invaluable in many ways. The data can be used to:
¢ Show potential patients how successful your rehabilitation program is. It can help you focus on
the health benefits of behavior change, education and exercise when talking to them.

e Focus on the clinical outcomes experienced by your patients when talking to referring physicians.
This will help increase your program referrals.
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e Demonstrate to hospital department heads and administration how beneficial the rehabilitation
program really is for improving the health of patients in the community.

¢ Clarify for managed care groups and insurance companies the medical benefits and subsequent
cost savings of treating their insured members. This may gain you additional insurance coverage.

e Contribute to a statewide database capable of benchmarking the best practices in cardiac and
pulmonary rehabilitation. This information can be used to dramatically improve the performance of
your program and enhance the outcomes of your patients.

Levels of Outcome Measurement

There are three levels of outcome measurement.

1. Session/Daily Trending: The process of trending changes in the treatment plan, exercise
prescription and patient condition from session to session. This data is normally captured in a
system such as your telemetry system.

2. Program Outcomes: Documenting the benefits patients receive from participation in the
rehabilitation program. Measures are made prior to the start of the intervention and again at the
completion. These measurements made me made at additional follow-up periods. Program
outcomes measure the change the benefit, and/or the impact of the treatment in clinical terms,
health terms, behavioral terms, economic terms and senice terms. Orion Outcomes tracks
program outcomes.

3. Risk Profiling: Risk profiling demonstrates the change in risk for future medical events and
ultimately future medical cost. At this level of outcome, the impact of the program on risk factors
like lipid profile, hypertension, exercise, diet, smoking, diabetes, obesity, depression and stress
is examined. Orion Outcomes produces risk profiles.

Make Your Outcomes Count

Just because you employ the best set of tools to measure and report outcomes it does not make your
program great. Outcome tools can put you in control of powerful information quickly and efficiently. Or
they can enable you to make mistakes and waste valuable resources faster than ever. Outcome tools
can be part of a valuable decision support system, provided you use them wisely.

Outcomes tools and manuals provide the how of gathering information on program effectiveness but you
must add the why to build the bigger picture. All too often outcome measurement provides interesting
numbers and elegant graphs but fails to be actionable. An awful lot of outcome research is collecting
dust on shelves in rehabilitation programs. To awid having your outcome data serve as bookends, here
are some things to consider as you build your outcomes program.

First, understand that outcome data is a part of the continuous quality improvement process. In and of
themselves outcomes have no meaning without standardization and benchmarking.

e Ask yourself what you are going to do with the data you obtain?

e What decisions will be made based on this data?

e What actions could be taken or awided based on this information?

e What do you want to know at the end of this process?

¢ Does the study affect something you can actually change or is the information just nice to know?

e Remember to develop your program with an action plan in mind and remain focused on the goal as
you movwe forward.

Next, decide who will be involved in the outcomes process. (I want to measure outcomes on phase four
patients, why?)

Depending on your action plan you may want to include different groups of patients and staff. Once you
have decided on your objectives you can select your tools.
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Moving from QA to CQl

Since the mid 1990’s, Orion Software Development has been the leader in providing tools to measure
improved quality in health care. The fundamental purpose of this company is to assist specific health
care programs in the ewolution from Quality Assurance (QA) to Continuous Quality Improvement (CQl).
For years, the means to assess and improve quality in health care included only local medical audits
followed by ongoing monitoring and simple evaluation. Today, Orion Software Development provides a
comprehensive tool set, in Orion Outcomes, to provide a more positive and structured approach to
continuous quality improvement in health care. If health care providers can use the tools of continuous
quality improvement to achieve greater efficiencies in the delivery of health care senices, reduce costs,
and improve quality, they will demonstrate outstanding leadership for improving the lewvels of quality in
their products and senvices and for the quality in health care.

In its 1991 quality assurance (QA) standards, the Joint Commission on the Accreditation of Hospital
Organizations specified a process by which the quality of care should be monitored and evaluated. This
process involves:

1. Identifying important aspects of care and senice provided by an organization or a department.
2. Using indicators to monitor important aspects of care and senice in an ongoing way.
3. Evaluating the care and senice to identify opportunities to improve the quality of care and senvice.

4. Taking action to improve care and senvice or to solve problems, and evaluating the effectiveness of
these specific actions.

This process of monitoring and evaluation is performed by most health care organizations or department
to meet quality assurance activities required by the Joint Commission.

In the ewolution to continuous quality improvement, the ability of organizations and departments to
assess, monitor and evaluate indicators has improved well beyond peer review and medical audits.
Improved tools and technology have come together to quickly advance our knowledge of and experience
with assessing and improving quality. This is especially important in the current health care environment
that stresses cost containment and concrete demonstration of quality and performance.

This growth in knowledge and technology to improve the quality of health care has led to a defined
process of continuously improving quality. Briefly, this process suggests that health care quality can
most effectively be improved by:

1. Focusing on all key components of the organization or department, including direct patient care,
management, and support senvices.

2. Coordinating continuous quality improvement processes throughout the organization or
department.

3. Using valid and reliable performance measures to collect pertinent data and using advance
technology analyze and externally benchmark performance.

4. Addressing processes and treatment that have important direct or indirect effects on patient
outcomes.

5. Focusing on opportunities to improve these processes rather than looking only for variance from
past performance or outcomes.

To continuously improve the quality of patient outcomes, an entire organization or department, from the
management to the support senices and providers, should be committed to a cooperative effort to
improve care. The opportunities to improve care will mostly be found by examining externally
benchmarked outcomes that evaluate the systems and processes by which the patient care is provided.

Patient Care and treatment outcomes will be improved not by focusing on outliers or the exception but
by looking at the processes that compose any key component of treatment in the organization. For
example, the processes inwlved in rehabilitation—ordering rehabilitation, patient assessment, preparing
the individualized treatment plan, providing treatment and monitoring patient outcomes — compromise
the steps performed by therapy professionals and other staff. Improvements in these processes will
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result from eliminating redundant steps, overly complex activities, barriers to communication, and so
forth. To carry out such quality improvement, meaningful data will be necessary. The usefulness of this
data will depend on the use of valid performance measures and the application of reliable data collection
techniques and statistical methods.

The ultimate goal of this coordinated, comprehensive, systematic process should result in a continuous
cycle of assessment and improvement in patient care.

It is important to remember that the concept of continuously improving quality incorporates the strengths
of quality assurance while broadening its scope, defining the process of assessing, evaluating and
improving care. So the process of structured monitoring and evaluation provides the foundation for
continuous improvement of quality. Developing methods of monitoring components of care and senice
and taking specific actions to improve care and senvice are the foundation of performance improvement.

Performance improvement initiative will include the following:
1. Emphasizing the role of management in improving quality.

2. Expanding assessment and improvement activities beyond the clinical measures and percentage
of change to clinical processes that affect the patient outcomes.

3. Using other external sources of feedback (benchmarking senices) to trigger evaluation and
improvement of patient care and processes.

4. Organizing the assessment and improvement activities around the flow of patient care and
senices.

5. Focusing first on the processes of care and senice rather than on the performance of individuals.
6. Maintaining improvement over time and seeking additional improvement.

Outcome assessment, external benchmarking and data evaluation are the components of the process
by which health care is, on an ongoing basis, assessed and improved.

Getting Started

Once you hawe installed the software on your computer, you should perform the following steps to
ensure the best usage of this software.

Before you begin using the software

The first thing you should do before getting started with this software is to fully understand the outcome
data collection methods outlined in the Indiana Society of Cardiovascular and Pulmonary Rehabilitation
(ISCVPR) Outcomes Program Manual. This document will act as your guide to the outcome collection
process. This manual was installed along with the software. You will find an icon that will launch the
manual on the help menu inside Orion Outcomes. This manual requires Microsoft Word 97 word
processing software for viewing. If you do not hawe this software, we have provided a viewer on the CD
that this software came on.

Additional audio/video tutorials have been provided on the Orion Outcomes CD-ROM.
Verify proper program setup

When you run this program for the first time, you will be asked to fill out the program profile forms.
These forms ask you to enter details about the staffing of your program, as well as the components that
make it up. If you did not completely fill out these forms, you may still do so by selecting the Activities
menu on the menu bar above the Navigator. Then, click on Edit and Program Profile. Once these forms
are completed, your rehabilitation program is ready for entering patient data.

Entering patient profiles

Each patient that is involved in your program must have a patient profile. A profile may be created by
pressing the Edit Patient Profile button on the Navigator. Select the (Add a New Patient) entry shown at
the top of the list of patients. You may now enter all of the information about the patient and their
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involvement in your program. Should you need to edit this information again later, you may return to this
screen Via the same procedure except choose the name of the patient from the list of patients.

Collecting patient outcome data

To enter the outcome data that you hawe just collected for a patient, press the Enter Outcome Data
button on the Navigator. Select the desired patient from the list of patients. If the name of the patient
does not appear in the list, you must create a profile for this patient before continuing. Evaluation
phases for data entry are chosen in the upper right hand corner of the Patient Outcomes View window.
Be sure to set the evaluation phase selector in the upper right hand corner to the correct phase before
entering the data.

Sharing your data with others

Every 90 days, the software will remind you to export your outcome data for benchmarking. The
software will walk you through sending your data by Internet or by mail. You should put a Business
Associate Agreement (BAA) in place with Orion Software Development prior to initiating a benchmarking
export.
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Installing or Removing

Installing the Software

Before installing this software on your computer:

1. Read the Orion Outcomes Software End User License Agreement that is included at the end of this
document.

2. Make sure that your package is complete. It should contain:
e Orion Outcomes User's Manual
e Orion Outcomes CD-ROM
e Outcomes Program Manual
3. Make sure that your computer configuration meets the following requirements:
e Personal computer with Pentium 75-MHz or higher

e Microsoft Windows 95 or later operating system, Microsoft Windows NT Workstation operating
system version 4.0 Senice Pack 3 or later

¢ 8 MB RAM minimum (16 MB RAM recommended)
e 45 MB of available hard-disk space required
To install Orion Outcomes onto your personal computer:
1. Before you set up the Orion Outcomes, make sure that your CD-ROM drive is properly installed.
2. Start the Microsoft Windows operating system.

3. Insert the CD into your CD-ROM drive. The setup program should start automatically. If it does,
proceed to step 7.

. Click the Microsoft Windows Start button, point to Settings, and then click Control Panel.

4
5. Double-click the Add/Remove Programs icon.
6. Press the Install button.

7

. Follow the setup instructions that appear on your screen. You will have the option to install Orion
Outcomes as well as view training materials on the CD-ROM.

8. When you run Orion Outcomes for the first time, you will be asked to enter your registration
information. You will find your product serial number attached to the front of this document or on
the back of the CD-ROM case. In addition, you will be asked to enter the names of your cardiac
and pulmonary programs. The program names that you enter during this part of the setup will be
the names that the benchmarking senices will use for reporting your outcome data.

Removing the Software

To remove Orion Outcomes files from your personal computer:
1. Close all programs.
2. Click the Windows Start button, point to Settings, and then click Control Panel.
3. Double-click the Add/Remove Programs icon.
4. Click Orion Outcomes on the Install/Uninstall tab, and then click Add/Remowe.
5. Press the Remove All button.
6. Follow the instructions on the screen.

NOTE: This operation will not remowve your outcome database from your computer. You will need to
manually delete it. This was done as an extra precaution.
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3 Getting Around

3.1 Navigator

The Navigator is the window that has the cardiac and pulmonary type selector along with the action
toolbar. This window allows you to access the main functionality of the program. For greater control,
use the menu bar that appears above this window.

ES Navigator - []

- b ORION
COMES

(&

| Profiles Enter contact, history and other

information for a patient,

3

Fecord the measurements taken
during a phase.

| Outcomes

patient or group outcomes,

| Reports @ Create detailed summaries of

Create visual summaries of
categorized outcame groups.

| Graphs

| Tracking

Find out when patients need to
return for their next phase.

3.2 Patient Profile View

This form allows you to setup a patient record for a participant in your program. Each participant must
have a patient record before outcome data can be entered for that patient.

10



Getting Around

3.3

Cardiac Patient Profile - New Patient E2

e New Patient

Caucasian

Outcome Data View

This form is for entering the outcome data collected on a patient during an evaluation phase. The tabbed
pages allow quick access to each of the major outcome categories. The name of the patient will appear
in the upper left corner of the window. In the upper right corner, you must select the evaluation phase for
which the data was collected. Select the correct phase before entering the data. If you need more
information on a particular field, place your cursor in the field and press the F1 key.

1



Orion Outcomes User Guide

3.4

3.5

12

Cardiac Patient Outcome Data

Patient:  Allen, Bill Evaluation Fhase: IPre Program v|

Be h aVi ora I Date of Test: El

Genaral |E‘.eck I Diet I Knowledge I

Behawioral Compliance

Follow Prescribed Diet: |4D - 59% v|
Follow Prescribed Medications: I == B0% '|

Cigarettes Smoked per Day: I 2
Exercise activity

Days per YWeek of Exercise: I =}
Minutes Exercising per Session: I 34

i | Ok Cancel

Lists

Lists are a method for viewing, sorting, and grouping data in your own customized ways. From the
menu bar, choose the Lists menu.

The lists have the ability to group data by multiple columns, sort columns, and show/hide columns.
The lists are printable so you may create your own view of the data you are interested in.

Tracking

This form allows you to specify the details for creating your tracking report. These reports are used to
schedule the upcoming follow-up evaluations for your patients.

E]

Rehabilitation Program

In the Multi-Program Edition of this software, you have the ability to choose which rehabilitation program
you would like to base the tracking report on.

Interval

You must select the time interval that you are interested in cowering in the report. Only patients who
have an evaluation due during that period of time are shown. You may choose one of the pre-selected
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time intervals or enter your own custom dates.

Options

This form allows you to enter various settings that customize the software.

Show Tools

Options

IJse the Following to seleck or deselect outcomes tools, IF tools are
deselected, the Figlds will nat appear in the data entry screens, Mo
previously collecked data will be deleted From hidden tools,

Shaw Tools ]Exp-:-rt | Formatting | SF-36 Scoring | Security | Lists | qudt |

Enowledge Test

Patient SatisFaction
Cualiby of Life Index
SF-12w2™ Health Survey
SF-36w2™ Health Survey

Six Minute Diskance Wialk

K KX R EEEEE

Treadmill Test

Mew England Cardiac Functional Capacity Test

Shartress of Breath Questionnaire

C

Zancel

This screen shows a list of available outcomes tools. You may select or deselect to show and hide tools
respectively. If you are not using a particular tool in your program, you may want to disable the tool so
that it simplifies your data entry screens. Deselecting a tool does not delete the data for the field; it

merely hides the data entry screens.

Export

13
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Options

Show Tools  Export | Formatting ] SF-36 Scaring ] Security ] Lists ] (ol L

Mame of your 3.5" floppy drive;  |4: -
Days between showing reminder: | 20

Mext date For export: Advance Date

FTPISFTF Proxy Server

Prouxy Server Type: ||{N|:|ne]| j
Address: | Pork; |
Lagin: |
Password: |

(o] 4 Zancel

e Name of 3.5" floppy drive: You have the option of setting the name of your 3.5" floppy drive that
will be used during the export process. For most personal computers, this drive is labeled A: but
for some it may not be. You may enter a single drive letter here if the configuration of your
computer is different.

¢ Number of days between showing reminder: You have the option of setting the interval of
days between showing reminder messages for exporting. After this interval of time has passed, a
reminder message will appear as you start the software. The only way to quiet this reminder is to
perform the export operation.

o Next data for export: This is the date when you are responsible for completing your next export.
The date is calculated from the date of your last export plus the number of days selected in the
previous option.

¢ Advance Date: If you do not want to submit your data for benchmarking when necessary, you
may press this button to increment the date forward. If you do not plan on sharing your data, you
may want to advance the date into the far future so you are never reminded.

o FTP/SFTP Proxy Server: If your IS/IT department has setup a proxy server, you will need to get
additional configuration information from them to enable Internet benchmarking submissions.
When in doubt, leave this section empty and check with your IS/IT department.

Formatting
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Options
' Shaw Tools | Export  Formatting | 5F-36 Scaring | Security | Lists | it [ ®
Repoart Patient Mame Format: |D|:|e, Jchn j

[ Print medical recard information on patient repart
Report Date Format: |{'-.-'-.-'inu:|u::ws Long Dake) j
0K Cancel

e Report Patient Name Format: You have the option of setting the format for how patient names
are shown on reports. Options include showing different combinations of first name, middle name,
and last name.

¢ Print medical record information on patient report: Some programs are required to have
medical record information on patient reports when they are archived in a medical record.

¢ Report Date Format: The date on which you print a report is shown in the lower left hand corner
of most reports. You may want to customize the data format according to your preferences. There
are several formats to choose from. (Windows Long Data), (Windows Short Date) and (Windows
General Date) are defined in your Windows control panel in the Regional settings. In other date
formats listed, m is for month, y is for year and d is for day.

Security

15
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Options

 Show Tools ] Export ] Formatting ] SF-36 Scoring  Security lLists ] (ol L

Inactivity Timeout: |0 Minutes (Sefk to 0 to disable)

oK Cancel

¢ Inactivity Timeout: HIPPA regulations require that unattended applications, which provide
access to protected health information, automatically exit after a specified period of time. Orion
Outcomes allows you to configure the amount of the timeout. If you set the timeout to 0, it will
disable the timeout.

3.7 Import and Export Wizard

This wizard is the main mechanism for moving data in and out of this software. After selecting an action
from the list, you will be guided through the procedure for the transfer.

16
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Import and Export Wizard

Choose an action to perform;

H art data rar 1Chimar -Jrll
Impork From LSI TrensCenter
Impart From Quinton Q-Progress
Impart from ScotkCare TeleRehab
Import From previous wersion
Migrate from Heartswatchers COMET

— Descripkion

Exports the patient daka over the Internet ar
onto & set of disketkes.

< Back Mextk = Cancel
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Working with Patients

Adding New Patients

To add a new patient to the database, follow these steps:

1. Select the type of program you wish to add the new patient to from the Navigator.

2. Press the Edit Patient Profile button on the Navigator.

3. Select the (Add a New Patient) entry from the top of the list and click OK.

4. You must now fill in the general information about the patient about the Patient Profile View.
NOTE: A minimum of a first and last name is required to create a valid patient record.

Deleting Patients

To delete the record of a given patient, follow these steps:
1. Select the type of program that the patient is in from the Navigator.
2. Open the record for the patient by pressing the Edit Patient Profile button on the Navigator.
3. Select the name of the patient you wish to delete from the list of patients and click OK.

4. Once in the Patient Profile View window, select the Edit menu on the menu bar and choose the
Delete Record option. The form will close and the patient data will be deleted.

NOTE: All data for this patient is deleted permanently and cannot be retrieved.
Entering Outcome Data

To enter outcome data for a patient, follow these steps:
1. Select the type of program that the patient is in from the Navigator .
2. Press the Enter Outcome Data button on the Navigator .

3. Select the name of the patient from the list and click OK. If the patient does not appear in the
list, you must add the patient first.

4. You may now enter the outcome data on the Outcome Data View. Be sure that the evaluation
phase selector in the upper right hand corner is on the correct evaluation phase for the data you
have collected before you enter the data. Press OK when finished.

Tracking Patient Visits

Patient tracking allows for accurate scheduling of the upcoming evaluation dates of returning patients.
The patient visit schedules are based on the following durations:

e Pre-Program to Post-Program: 3 months
¢ Post-Program to 6 Months from Pre-Program: 3 months
e 6 months from Pre-Program to 1 year from Pre-Program: 6 months
¢ 1 year from Pre-Program to 2 years from Pre-Program: 1 year

e 2 years from Pre-Program to 3 years from Pre-Program: 1 year

e 3 years from Pre-Program to 5 years from Pre-Program: 2 years

e 5 years from Pre-Program to 7 years from Pre-Program: 2 years

7 years from Pre-Program to 10 years from Pre-Program: 3 years

All patient tracking is done automatically based on the previous evaluation dates of the patient. After
selecting tracking on the Navigator, you will see the Tracking form. You are asked to enter a starting
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date and an ending date. All patients who have an evaluation due during this period of time will be
printed on the tracking report. The telephone numbers of the patients are printed along with the name of
the patient in order to create a calling list.

NOTE: If a patient's testing date falls before the starting date of the range that you enter, the patient will
not show up in the report.

Classifying Patients
Diagnosis

You may choose the primary and secondary diagnosis of your patient. Some of the most common
choices are available. If your patient has a diagnosis that is not on the list, please select other for the
diagnosis. You cannot add a diagnosis to this list. In addition, the option of none is also available as a
secondary diagnosis choice.

Exercise Sessions Completed

Record the number of exercise sessions that the patient was involved in during the rehabilitation
program. Only phase 2 exercise sessions are to be counted.

Identifier

You may use this field to record any extra information that you would like to keep on the patient. You
may want to store their Social Security number, email address, or some other type of identification
number. This field is not used in outcome data reporting and is not required. Some facilities have
chosen to use this field to record an ID that is cross-referenced in their hospital’s database.

Insurance Provider

You may enter an insurance provider for your patient. Doing this will allow you to breakout patients from
a given provider in reporting so that you can share the outcomes of those patients with the provider. |If
there was no specific insurance provider, simply leave the field blank.

Maintenance Program

This option should be set if the patient is involved in a maintenance program. This is any phase 3 or
phase 4 program that occurs once the patient completes the rehabilitation program.

Referring Physician

You may enter a referring physician for your patient. Doing this will allow you to breakout patients from
a given physician in reporting so that you can share the outcomes of those patients with the physician.
If there was no specific referring physician, simply leave the field blank.

Risk Stratification
Cardiac Risk Stratification
These are the guidelines for classifying the risk stratification of a cardiac patient.

Low Risk

¢ No significant left ventricular dysfunction (i.e., ejection fraction equal to or greater than 50%).

¢ No resting or exercise-induced myocardial ischemia manifested as angina and/or ST-segment
displacement.
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No resting or exercise-induced complex arrhythmias.

Uncomplicated myocardial infarction, coronary artery bypass surgery, angioplasty or
artherectomy.

Functional capacity greater than or equal to 7 METs on graded exercise test 3 or more weeks
after clinical event.

Intermediate Risk

Mild to moderately depressed left ventricular function (ejection fraction 40-49%).

Functional capacity less than 5-6.9 METs on graded exercise test 3 or more weeks after clinical
event.

Failure to comply with exercise intensity prescription.

Exercise induced myocardial ischemia (1-2 mm ST-segment depression) or reversible ischemic
defects (echocardiographic or nuclear radiography).

High Risk

Sevwerely depressed left ventricular function (ejection fraction of 40% or less).
Complex ventricular arrhythmias at rest or appearing or increasing with exercise.

Decrease in systolic blood pressure of greater than 15 mm Hg during exercise or failure to rise
with increasing exercise workloads.

Sunvivor of sudden cardiac death.

Myocardial infarction complicated by congestive heart failure, cardiogenic shock, and /or complex
ventricular arrhythmias.

Severe coronary artery disease and marked exercise-induced myocardial ischemia (>2 mm ST-
segment depression).

Functional Capacity less than 5 METs.

4.5.7.2 Pulmonary Risk Stratification

22

Generally accepted guidelines for the risk stratification of the pulmonary patient are currently unavailable.
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Collecting Outcome Data

Behavioral Outcomes

Diet Habit Survey

The Diet Habit Survey measures cholesterol-saturated fat intake, complex carbohydrates, and salt.
Estimated time for patient to complete the test is as much as 30 minutes.

Knowledge

To administer the knowledge test, follow these steps:

1

. The cardiac and pulmonary knowledge tests should be administered after the completion of the

Health Status Questionnaire. Like the Health Status Questionnaire, it should not be sent home
with the patient for completion. Answers to the test should be placed on the Knowledge Test
Answer Sheet in the Outcomes Program Manual.

. Patients are not required to fill out the knowledge test. If the patient refuses, explain to them that

the test is woluntary, but it will provide helpful information regarding the quality of the education
program provided by your rehabilitation program. Do not force the patient to fill out the
questionnaire.

. The knowledge test should be filled out by the rehabilitation patient only. They may not receive

help from spouses, family members or other guests. If the patient does not speak English, a
translator may be used.

. If the patient is unable to read, the knowledge test may be given by reading the test to the patient

and having them answer orally.

. If the patient does not understand a particular item, the question may be read to them verbatim,

but not rephrased.

. If a patient asks for an interpretation of a particular question, do not try to explain what the

question means. Ask the patient to answer the question based upon what they think it means.

. When the patient returns the knowledge test, carefully check to see that the test has been

completed. Ifit is not, ask the patient why the test is incomplete and encourage them to answer
the remaining questions.

. Inform the patient that they will be asked to fill out the same test at the end of the program.

Explain that this will give a better picture of the patient's learning over the course of time.

. Score the test using the key provided in the Outcomes Program Manual. Unanswered questions

are counted as wrong. Record the number of correct answers on the outcome data sheet.

Smoking

Record the average number of cigarettes currently smoked per day by the patient.

Behavioral Compliance

Diet

This outcome measures the percentage of the time that the patient follows their prescribed diet.

Choices are:
e < 20%
e 20— 39%
e 40 - 59%
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e 60 —79%
e >=80%

Medication

This outcome measures the percentage of the time that the patient follows their prescribed medication.
Choices are:
e < 20%
20 — 39%
40 — 59%
60 — 79%
e >=80%

Exercise Activity

Exercise

Two measures are collected:

¢ Record the average number of minutes spent exercising per day by the patient. This includes
time in rehabilitation class as well as time at home.

¢ Record the average number of days spent exercising per week by the patient. This includes time
in rehabilitation class as well as days at home.

Clinical Outcomes

Duke Activity Status Index

The Duke Activity Status Index (DASI) measures functional status via changes in perceived exertion.
Estimated time for patient to complete the test is less than 5 minutes.

The total score for the DASI is given in units of VO2, which is a measure of oxygen uptake. Orion
Outcomes will automatically take the VO2 score and approximate the MET value by the following
formula:

DASI_METs = ( DASI_VO2*0.43+9.6)/3.5
Height

Record the height of the patient in inches.
Lipid Profiles

Some guidelines for collecting lipid profiles are:

1. If these laboratories have been performed prior to the start of the rehabilitation program include
them in the Pre Program phase data. Lipid profiles taken within the six months before the start of
the program can be used for Pre Program lipid profiles.

2. At the completion of the rehabilitation program, have these laboratories drawn and record the
results as the Post Program phase data.

3. These labs can be repeated at any of the other evaluation phases as well.
NOTE: These outcomes are only measured for cardiac patients.
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METs

The program automatically calculates metabolic equivalents as a function of the horizontal distance
walked during the six-minute walk. This software uses a formula published by the American College of
Sports Medicine.

NYHA Functional Classification

The New York Heart Association (NYHA) functional classification is most often used to characterize
patients' limitation from left ventricular failure. Since 1973, the New York Heart Association has not
officially sanctioned the functional classification. However, it continues to be used widely and has a
strong association with mortality that is independent of left ventricular ejection fraction.

Class Definition

l. No limitation of physical activity. Ordinary physical activity does not cause undue fatigue, or
dyspnea. MVO2 greater than 21 ml/kg/min (> 7 METSs).

Il. Slight limitation of physical activity. Comfortable at rest, but ordinary physical activity results in
fatigue, or dyspnea. MVO2 from 14 to 21 ml/kg/min (5-6 METs).

M. Marked limitation of physical activity. Comfortable at rest, but less than ordinary activity causes
fatigue, or dyspnea. MVO2 from 7 to 14 ml/kg/min (3-4 METSs).

V. Unable to carry on any physical activity without symptoms. Symptoms are present even at
rest. If any physical activity is undertaken, symptoms are increased. MVO2 less than 7 ml/kg/min (< 2
METSs).

Use in Congestive Heart Failure (CHF)

CHF is diagnosed only if the patient has at least two different symptoms and/or signs of CHF (one
symptom and one sign, two symptoms, or two signs): shortness of breath, easy fatigability, edema,
orthopnea, paroxysmal nocturnal dyspnea, jugular venous distention, rales, or S3. The NYHA functional
class for CHF depends upon the amount of physical activity the patient is able to perform without
experiencing symptoms of fatigue or dyspnea. A patient able to ascend one flight of stairs without
symptoms, or walk one block with a mild to moderate incline is classified as a New York Heart
Association Class [, unless that same amount of activity resulted in excessive fatigue or dyspnea, in
which case the classification is Class Il. If walking from the kitchen to the living room causes
symptoms, the patient is classified as Class Ill. Symptoms occurring at rest or with minimal activity are
considered Class IV.

Consistency in both the physician and coordinator internviewing the patient, and the type of questions
asked of the patient regarding his activity and symptoms, is important throughout the trial.

Reference

Diseases of the Heart and Blood Vessels - Nomenclature and Criteria for Diagnosis, 6th edition, Boston,
Little Brown and Company, 1964.

Percent Body Fat

Record the percent body fat of the patient. This measure can be determined through a method of
choice.

Rating of Perceived Dyspnea (RPD)

The scale used to measure RPD is as follows:

1 Mild - noticeable to patient to observer.
2 Some Difficulty - noticeable to obsener.
3 Moderate difficulty - but patient can continue.
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4 Sewere difficulty - patient cannot continue.
NOTE: This measure is used for pulmonary patients only.

Rating of Perceived Exertion (RPE)

6
7 Very, Very Light
8
9 Very Light
10
11 Fairly Light
12
13 Somewhat Hard
14
15 Hard
16
17 Very Hard
18
19 Very, Very Hard
20
Weight

Record the body weight of the patient in pounds. Measure patients with shoes off and their choice of
clothing depending upon circumstances. The most important part is to weigh people the same each
time.

Six-Minute Distance Walk

Six-Minute Cardiac Distance Walk

The 6MDW should be administered before or at the beginning of the first exercise session of the
rehabilitation program and at the last exercise session of the program. Walks should take place at
about the same time of day, at least two hours following a meal and should be the first activity of the
exercise session. A quiet indoor hallway that is at least 100 feet in length would make a suitable
walking location.
Equipment

e Outcome Data Sheets (Appendix D of the Outcomes Program Manual)
Rolling distance marker
Stopwatch

Heart monitor
Borg Scale (Appendix D, page 64 of the Outcomes Program Manual)
e Chair

Exclusion Criteria

Patients with musculoskeletal problems that preclude walking such as intermittent claudication,
paralysis, and pain.
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Protocol

1.

Measure and record the patient’s height and weight. Before the walk, have the patient rest in a
sitting position for 5 minutes. After this rest period, blood pressure and heart rate, are measured
for all patients. Record all the data on the outcome data sheet.

. The following instructions will be given to the patients: "The purpose of this test is to find out how

far you can walk in six minutes. You will start from this point (indicate marker at one end of the
course) and follow the hallway to the marker at the end, then turn around and walk back. When
you arrive back at the starting point, you will go back and forth again. You will go back and forth
as many times as you can in the six-minute period. If you need to, you may stop and rest. Just
remain where you are until you can go on again. Howewer, the most important thing about the test
is that you cover as much ground as you possibly can during the six minutes. | will tell you the
time, and | will let you know when the six minutes are up. When | say stop please stand right
where you are."

- During the walks, the following words of encouragement will be provided at 30-second intervals:

"You are doing Well," "Keep up the good work," "Good Job," and "You are doing fine."

. The monitor will walk behind the patient so as not to influence the patient’s pace and will attempt

to face the subject only when offering encouragement.

. Patients are told when 2, 4, and 6 minutes (stop) have elapsed.
. Immediately following completion of the walking test, have the patient sit down and evaluate for

heart rate, blood pressure, rating of perceived exertion (Borg Scale) and total distance walked in
feet. Record the results on the outcome data sheet.

. After the patient has rested for exactly five minutes, measure and record their heart rate and blood

pressure on the outcome data sheet as the recovery value for the outcome.

5.2.10.2 Six-Minute Pulmonary Distance Walk

28

The 6MDW should be administered before or at the beginning of the first exercise session of the
rehabilitation program and at the last exercise session of the program. Walks should take place at
about the same time of day, at least two hours following a meal and should be the first activity of the
exercise session. A quiet indoor hallway that is at least 100 feet in length would make a suitable
walking location.

Equipment

Outcome Data Sheets (Appendix D of the Outcomes Program Manual)
Rolling distance marker

Stopwatch

Oxygen saturation monitor

Dyspnea Scale (Appendix D of the Outcomes Program Manual)

Heart monitor (optional)

Chair

Exclusion Criteria

Patients with musculoskeletal problems that preclude walking such as intermittent claudication,
paralysis, and pain.

Protocol

1.

Measure and record the patient’s height and weight. Before the walk, have the patient rest in a
sitting position for 5 minutes. After this rest period, blood pressure, heart rate, SaO2 and rating of
perceived dyspnea are measured for all patients. Record all the data on the outcome data sheet.

2. If resting Sa02 is below 85% without supplemental oxygen or below 90% with oxygen do not
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perform the test. Take appropriate action and reschedule testing for another day. Patients on
supplemental oxygen will use their oxygen at the prescribed flow rate for exercise.

3. The following instructions will be given to the patients: "The purpose of this test is to find out how
far you can walk in six minutes. You will start from this point (indicate marker at one end of the
course) and follow the hallway to the marker at the end, then turn around and walk back. When
you arrive back at the starting point, you will go back and forth again. You will go back and forth
as many times as you can in the six-minute period. If you need to, you may stop and rest. Just
remain where you are until you can go on again. However, the most important thing about the test
is that you cover as much ground as you possibly can during the six minutes. | will tell you the
time, and | will let you know when the six minutes are up. When | say stop please stand right
where you are."

4. During the walks, the following words of encouragement will be provided at 30-second intervals:
"You are doing Well," "Keep up the good work," "Good Job," and "You are doing fine."

5. The monitor will walk behind the patient so as not to influence the patient’s pace and will attempt
to face the subject only when offering encouragement.

6. Patients are told when 2, 4, and 6 minutes (stop) have elapsed.

7. Patients should have their oxygen saturation monitored continuously during the test. If saturation
levels fall below 80%, stop walking and discontinue the test. Record the lowest oxygen
saturation observed on the outcome data sheet.

8. Immediately following completion of the walking test, have the patient sit down and evaluate for
Sa02, heart rate, blood pressure, rating of perceived dyspnea, and total distance walked in feet.
Record the results on the outcome data sheet.

9. After the patient has rested for exactly five minutes, measure and record their heart rate, blood
pressure, oxygen saturation and dyspnea level on the outcome data sheet as the recovery value
for this outcome.

Economic Outcomes

Number of Medications

Record the number of prescribed medications that the patient is currently taking on the given evaluation
date.

Medical System Utilization
ER Visits

Record the number of visits that the patient has made to the emergency room since their last evaluation.
If this is their first evaluation, consider any visits that occurred during the past year. Include all visits,
not just those related to the cardiac or pulmonary problem.

Hospital Admissions

Record the number of admissions that the patient has made to a hospital since their last evaluation. If
this is their first evaluation, consider any visits that occurred during the past year. Include all
admissions, not just those related to the cardiac or pulmonary problem.

Physician Visits

Record the number of visits that the patient has made to physicians since their last evaluation. If this is
their first evaluation, consider any visits that occurred during the past year. Include all visits, not just
those related to the cardiac or pulmonary problem.
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Health Outcomes

Quality of Life Index

The Quality of Life Index (QLI) was developed by Carol Estwing Ferrans and Marjorie J. Powers in 1984
to measure quality of life in terms of satisfaction with life. The QLI measures both satisfaction and
importance regarding various aspects of life.

There is no charge placed on the use of this tool by the author.
More information at http://www.uic.edu/orgs/qli/

Q: When some questions don’t apply, what should you do (for example, if the client has no children)?

A: There will always be at least one question with missing data, because the two employment questions
are mutually exclusive. We also anticipated that a few other questions (such as children) would not
apply to everyone. The scoring program for the QLI was developed in such a way that there is no need to
replace missing data for items that truly do not apply. Scores will be calculated based on the items
answered for each person, and will all range from 0 to 30, even with no replacement for missing data.

Q: What does it mean that the scores are "weighted"?

A: Each matched pair of satisfaction and importance questions are combined, so that the scores tell
you how satisfied the person is with the things that matter most to him. The importance to the person
determines how much impact the satisfaction rating has on the final score. For example, combinations
of high importance and high satisfaction produce the highest scores. Combinations of high importance
and high dissatisfaction produce the lowest scores. Things that are of little importance have a smaller
impact on the score.

Q: How do | use this information clinically?

A: You can use both the scores and items for your clinical practice. To give you an idea of what scores
should cause concern, you can compare them with general population data. For example, let’s say a
client has the following scores:

Your Client's Scores General Population Mean
Ovwerall 17.9 22.1
Health and functioning 14.6 20.9
Social and economic 19.1 22.9
Psychological/Spiritual  |19.1 22.5
Family 28.5 24.5

Scores of 19 and below usually indicate a poorer quality of life in these areas. For this client, | would
think that these scores indicate he/she is experiencing a poor quality of life regarding health and
functioning, indicating there are significant problems here. The two subscales of 19 for social and
economic and psychological/spiritual also indicate there are problems, but not as severe. The family
subscale of course indicates that this client has a high quality of life in this area. The total score
indicates that this client is experiencing a relatively poor quality of life in general.

You can also compare the client’s own scores with each other over time. For example, you can compare
scores when he enters your cardiac rehabilitation program and then 3 months later. Previous studies
have shown that a difference of 2-3 points is a clinically meaningful difference. A difference of 2-3 points
in the total score of the Quality of Life Index has been associated with significant improvement in overall
quality of life, self-image, physical symptoms, and general health in studies assessing change in quality
of life.

To dewelop a treatment plan, you can examine the individual items in the subscales indicating problems,
to identify the areas that have the greatest dissatisfaction and are also the most important to the client.
These would be the primary target areas.

Q: What are considered the "norms" for a cardiac or pulmonary patient?
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A: Because there are wide ranges of severity of illness in cardiac and pulmonary diseases and
treatments (for example, clients who have had bypass surgery, angioplasty, valve replacement, anti-
arrythmics, etc.), there are no norms for cardiac and pulmonary patients, although you can compare
your client’s scores with a large number of studies that have used the Quality of Life Index. A listing of
these can be found on our website at http://www.uic.edu/orgs/qgli. The recommendation is to use the
general population for your comparison, since the ultimate goal is to achieve a quality of life as close to
normal as possible.

Q: In what period of time would you expect to see changes, for example, 6 weeks or 12 weeks?

A: There is no answer to this question that would apply across all clients. However, we do know that
angioplasty patients have shown significant improvement within 6 weeks after angioplasty and 3 months
after bypass surgery, using the Quality of Life Index. The key is that there needs to be enough time for
the client to see the translation of the intervention into the quality of their lives.

Q: We hawve heard that the SF-36 is a better measure. How does the Quality of Life Index compare to the
SF-367

A: The Quality of Life Index was found to be more sensitive to change than the SF-36 in a study of
arrhythmia patients. All the participants completed both instruments. They also completed another
questionnaire that specifically measured changes in arrhythmias. The arrhythmia-specific questionnaire
was the most sensitive in detecting changes in arrhythmia, and the Quality of Life Index was the next
most sensitive. The SF-36 was the worst of the three in detecting change in these patients. For more
information, there is a review article that compares the Quality of Life Index with three other measures:
DeVon, H. & Ferrans, C. (2003). Psychometric properties of four quality of life instruments used in
cardiovascular populations. Journal of Cardiopulmonary Rehabilitation, 23, 122-138.

Custom Outcomes

Using Custom Outcomes

Orion Outcomes provides a large set of standardized outcome tools that are known to be valid, reliable
and well known across the discipline. While most users find this set to be sufficient for their needs, there
are times when users wish to experiment with or use other outcome tools not currently supported by
Orion Outcomes.

Custom Outcomes is the Orion Outcomes method of allowing you to collect outcome data using tools
that are not supported by Orion Outcomes out of the box. These outcomes are placed in an outcomes
domain called Custom. The custom outcomes act just as standard outcomes except that they are not
benchmarked.

Orion Outcomes comes with 2 complimentary custom outcome fields (1 cardiac, 1 for pulmonary). The
ability to add up to 46 additional outcome fields (23 cardiac, 23 pulmonary) is available for an additional
cost. Orion Software Development chose to offer this capability as an add-on because only a smaller set
of customers required this functionality.

Adding a Custom Outcome

To add a custom outcome, follow these steps:
1. Select the Tools menu, then Options.
2. Select the Custom tab. The window shown below will appear.
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Options

- Formatting ] SF-36 Scoring ] Security ] Lisks ] Quinton  Cuskom l 1

Cuskom oukcomes are private data collection entries that you wish ko
make, These fields will be defined and used For all patients, They will nok
be available For external benchmarking.

Program Type: |Caru:|iau: j

To create more than one custom outcome, you must purchase
the custom outcome: add-on module from Orion Software
Development.

(o] 4 | Zancel |

3. Choose Cardiac or Pulmonary.
4. Press the Add button. The window shown below will appear.

-~

Define Custom Field
Complete all the fields to define your custom oukcome.,
Full Mame: |5h|:|e Size
Long Mame: |S|'u:|e Size
Shart Marne: [5hoe
it s: |Iru:hes

Cancel

5. Enter the information in the appropriate fields.

Full Name: This will be used as the name for the outcome when displayed in forms, not
reports.

Long Name: This will be used as the name for the outcome when it is displayed on reports
where moderate space is available.

Short Name: This will be used as the name for the outcome when it is displayed on reports
where limited space is available. Abbreviations are appropriate.

Units: Enter the units of measurement. This is normally something like feet, inches, pounds,
points, etc.
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Analyzing Your Data

Statistical Terms

Count

The count refers to the number of samples (usually patients) included in the measurement. This is often
labeled with the letter "n" on reports.

Kurtosis

This measure characterizes the relative peakedness or flatness of a distribution compared with the
normal distribution. Positive kurtosis indicates a relatively peaked distribution. Negative kurtosis
indicates a relatively flat distribution.

Mean

The mean of a set of data is the sum of the measurements divided by the number of measurements,
commonly referred to as the average.

Significance

Statistical significance is calculated using the counts, means, and standard deviations of the two
different samples. A one tailed Z-test is used if each of the samples has 30 or more members. For
smaller sample sizes, a T-test is used.

Textbook Definition

Is the mean of the sample in column 2 sufficiently different than the mean of column 1 to allow us to infer
at the 5% significance level that the population mean of column 2 is not column 17?

Or in Plain English

If the significance box is checked, then we are 95% sure (statistically) that there was a change in the
mean from column 1 to column 2. Therefore, your program has produced a noticeable change for this
measure.

Skewness

This measure indicates the skewness or "tail-heaviness" of a distribution by characterizing the degree of
symmetry of a distribution around its mean. Positive skewness indicates a distribution with an
asymmetric tail extending toward values that are more positive. Negative skewness indicates a
distribution with an asymmetric tail extending toward values that are more negative. This measure is
zero if the data are perfectly symmetric (because both the mean and median both equal the point of
symmetry).

Standard Deviation

The standard deviation is a statistic that tells you how tightly all the various data points are clustered
around the mean in a set of data. When the examples are pretty tightly bunched together and the bell-
shaped cune is steep, the standard deviation is small. When the examples are spread apart and the bell
cune is relatively flat, that tells you that you have a relatively large standard deviation.

The standard deviation is kind of the "mean of the mean," and often can help you find the story behind
the data.
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Percent Change

Percent change is not used within Orion Outcomes when comparing aggregate or program data.

Orion Software Development has experienced a concern with their customers regarding outcomes and
the AACVPR Cardiac and Pulmonary Rehabilitation Program Certification process. The current
certification process requires programs to focus on and report percentage of change for program
outcomes. While percentage of change is useful when reporting individual patient change, it is an out
dated measure for internal program data and confuses clinicians who use external program comparison
in the continuous quality improvement process.

The Joint Commission on the Accreditation of Hospital Organization moved from Quality Assurance (QA)
to performance improvement through the process of Continuous Quality Improvement (CQl) in 1992. The
use of percentage of change for program data is a QA measure because it provides a snapshot of
program performance at a point in time. As long as there is change, in the right direction, clinicians view
their program performance and quality of care as good. This is deceiving to clinicians! When outcomes
are compared to other programs through the benchmarking process, the relative change (percentage)
may be in the 90th percentile while the absolute change (units of measure) may be below the 10th
percentile of benchmarked programs.

Since 1997, Orion Software Development has provided cardiac and pulmonary rehabilitation programs
with the tools to drive performance improvement through CQI. Orion Outcomes, which is used in over
1500 cardiac and pulmonary rehabilitation programs nationwide, provides the software and tools for
outcome measurement, analysis, and benchmarking. The software, written materials, and training focus
on using CQI to improve outcomes across five domains and reduce patient health risks. Ultimately, this
process of performance improvement improves the quality of care provided by rehabilitation programs.

Each year, programs going through the certification process are confused and frustrated with Orion
Software because AACVPR, through its state and national certification committees, requests
information Orion awids providing for the reasons cited above. Each year, Orion Software has woiced this
concern to the Program Certification and Outcomes Committees. As a previous member of the
outcomes committee, Steve Jungbauer has advocated, "Cardiac and Pulmonary Rehabilitation programs
should demonstrate the use of internally and externally benchmarked outcomes in the continuous
quality improvement process for program certification."”

Orion Software Development is committed to helping transform rehabilitation programs from exercise
based to health risk intervention and reduction programs through the CQI process.

Patient Reports
Patient Reports

This report allows you to analyze the outcomes of a specific patient for any two given evaluation phases.
You must select the patient and the two program phases that you would like to compare. The report will
calculate the percentage change in each of the outcome data points for the given evaluation phases.
Health Status Profile

The Health Status Profile report is used to summarize the health outcome changes in a patient over a
given set of program phases. Select a patient and one or more program phases to generate the report.
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B Create a Health Status Profile Report |

To create a report that summarizes the health status of a patient, select the
patient and the phases o be analyzed.

Select 3 patient; Select the program phaszes o includs;
Allen, Bill ﬂ Pre Program

Allen, Donald Post Program

Applegate, George & Months

Barter, Chestar 1 Year

Bays, Turner 2 Years

Boehm, George 3 Years

Baolinger, Stephen 3 Years

Boyer, Richard 7 Years

Brow, Jay 10 Years

Brubaker, Lauriz

Burley, Robert

Clay, Evelyn

Collier, Bonita ﬂ

(0] 4 Cancel

6.3 Program Reports
6.3.1 Average Patient Profile

Overview

The average patient profile report is used to understand the base values in patient outcome data in
program evaluation phases. The report shows:

¢ Number of samples for each outcome in the two different evaluation phases chosen

¢ Mean values for each outcome in the two different evaluation phases chosen

¢ Standard Deviation for each outcome in the two different evaluation phases chosen

Form
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B Create an Average Patient Profile Repork

B

To create a report that summarizes your average patient profile aver a given set of phases, select
the phases to be analyzed and specify any filter parameters.

Display |5h|:|w Outcomes | Filters |

Title: |Cardia|: Avwerage Patient Profile

—Date Range

Compare

|F're Prograrm j phase data

to |F'|:|5t Program j phase data collected during

|Ir'u:|udeall dates j fru:um:l M 1J:|:| @l

M Limit to patients who have completed bath of selected phases

Cancel

You have the option of limiting the patients that are included in the report. For more information, see the
section on Filtering Data.

Report

The report looks like the following:

37



Orion Outcomes User Guide

Cardiac Average Patient Profile

Frogram ABC Communiy Hos pital
Thte Rgn.gg Inzluded al dates
Pro Program Pogk Program
" Jdagn STy " Jegn STy
Bahavioral Downaf
ﬁgﬂwk:ﬁgﬂ Test =] 2T 53 G.02 53 28032 5.17
ﬂ.gﬂmttg&' Shmoked e 021 2.7 32 oa1 205
Behavioral Conplianee
Follows [het =z 431 047 3z 453 072
Follows Medications 32 4497 012 32 00 0.a0
Exercize defwity
D;P_],.ls per Heek afE:cgmigg = 324 285 a8 2376 163
hdrades Emrci,s'ing per Shrsion = 1448 14853 28 4082 2118
Clinteal Domain
T el TR ARTET anad TR ASRAT A1 A1

6.3.2 Cardiac Risk Factor Analysis

This report allows you to compare an individual patient against the major cardiac risk factors. The data is
displayed in a more qualitative method by signifying high, medium & low for each of the risk factors.

6.3.3 Continuous Quality Improvement

This report will help you evaluate the levels of continuous quality improvement of your program. The
difference value for each outcome is reported by either month, quarter or year. Any patient who
completes the evaluation phase, which is chosen below after the "to", will be included in the calculation
for that month. This report takes the outcome data from the two phases for each patient and computes
the difference in each measure for each patient. Those differences are summarized program-wide and
reported on through many different statistical methods. The report shows the mean, minimum,
maximum, sum, and count for each outcome.

Form
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6.3.4

B Create a Continuous Quality Improvement (COI) Repork ﬂ

To create a report that summarizes the progress in the difference in outcame measurements that
your patients achieve, select the phases to be analyzed and specify any ather parameters.

Display |5h|:|w Figlds | Show Outromes | Filters |

Title: |C|:|ntinucuu5 Quality Improverment (CQD Report for Cardiac Program

—Date Range

Compare

|F're Prograrm j phase data

to |F'|:|5t Program j phase data collected during

|Ir'u:|udeall dates j fru:um:l M 1J:|:| @I

—Summarize by

& Month T Quarter T vear

o4 Cancel

Show Fields

This tab allows you to choose which of the statistical measures listed above will be included in the
report.

Show Outcomes
This tab allows you to choose which of the outcomes will be included in the report.
Filters

You have the option of limiting the patients that are included in the report. For more information, see the
section on Filtering Data.

Program Change Summary

The Program Change Summary report is used to analyze the change in patient outcome data between
two different program evaluation phases. This report takes the outcome data from the two phases for
each patient and computes the difference in each measure for each patient. Those differences are
summarized program-wide and reported on through many different statistical methods. The report shows
the mean, standard error, median, standard deviation, standard variance, kurtosis, skewness, range,
minimum, maximum, sum, count, and statistical significance, reported to the .05 level, for each
outcome.

Form
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B Create a Program Change Summary Repork ﬂ

To create a repart that summarizes the difference in outcome measurements that your patients
achieve, select the phases to be analyzed and specify any other parameters,

Display |5h|:|w Fields | Show outromes | Filters | order By |

Title: |Cardia|: Program Change Summary

—Date Range

Compare

|F're Prograrm j phase data

to |F'|:|5t Program j phase data collected during

|Ir'u:|udeall dates j fru:um:l M 1J:|:| @I

ok Cancel

Show Fields

This tab allows you to choose which of the statistical measures listed above will be included in the
report.

Show Outcomes
This tab allows you to choose which of the outcomes will be included in the report.
Filters

You have the option of limiting the patients that are included in the report. For more information, see the
section on Filtering Data.

Order By

This tab allows you to customize the order that the data will be sorted by and ordered by in the report.
Program Profile

This report is a summary of the information about your program. This information was entered during the
setup of the program. This report provides a summary of what facilities and components make up your
rehabilitation program.
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6.3.6

6.3.7

Program Statistics

This report gives a graphical display of some of the demographic breakdowns for the patients in your
rehabilitation program.

The report includes:

Age - shows the number of patients in 6 different age ranges
Insurance Providers - shows the top 10 providers and the number of patients associated with each
Hometown - shows the top 10 cities where in your patients are drawn from

Maintenance Program - shows the percentage inwolved versus the percentage not inwvolved in a
phase 3 or 4 program

Phase Participation - shows the total number of patients who have completed each of the
evaluation phrases

Primary Diagnosis - shows each of the diagnoses and the number of patients associated with
each

Referring Physicians - shows the top 10 physicians and the number of patients associated with
each

Risk Stratification - shows the percentage of patients in each classification
Sex - shows the percentage of males versus percentage of females

Change Summary Graph

This type of report is useful for visualizing the changes in your data. The data set is broken down into
different categories by outcome, which are graphed according to the evaluation phase. The mean value of
all patients is shown for each data point.
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B Create a Change Summary Graph ﬂ

To create a repart that summarizes the difference in outcome measurements that your patients
achieve, select the phases to be analyzed and specify any other parameters,

Display |5h|:|w Outcomes | Filters |

Title: |Cardia|: Change Summary Graph

—Date Range

Compare

|F'|:|5t Program j phase data

to |1EI Years j phase data collected during

|Ir'u:|udeall dates j fru:um:l M 1J:|:| @I

o4 Cancel

You have the option of limiting the patients that are included in the graph. For more information, see the
section on Filtering Data.

6.3.8 Options
6.3.8.1 Choosing Outcomes

You have the option of limiting the outcomes that appear on reports you are creating. All of the

outcomes are presented within their respective outcome domains. Place a check mark next to the
outcomes you wish to print and clear the checkmark from those you do not wish to print.
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Display | Show Fields  Show Outcomes |Fi|ters | Order By

Select the outcomes you wish to display. Double-click 2 node to collapse or expand it

------- O Beck Depression Inventory

------- @ Cigarettes Srmoked

------- Q Days per Week of Exarcise

....... & Diet Hahit Survey

------- @ Follows Diet

------- Q Follows Medications

------- 0 Knowledge Test

------- Q Minutes Exercising per Session
= Clinical

------- Body Mass Indesx
2 Pl | |nl:llln'| [ LI

Mark all | Clear All 57 Outcomes Selected

6.3.8.2 Filtering Data
On reports and charts, you have the option of restricting which patients are used in the analysis by

selecting filter parameters. To use a filter, place a checkmark in the box next to it by clicking on the
box. Then proceed to the right side of the form to complete the details about the filter you have chosen.

Display | Show Fields | Show Outcames Filters |Drder E.ﬁ,r|

Filters are resfrictions you place on a report to identify the specific patients you want 1o
include in your report. Select a parameter and then add the supporting details.

1. Select a parameter. 2. Add the details for this parameter.

m =1 —Details
O city
O nsurance Provider Cperation: I j
OMaintenance Program I_

OFrimary Diagnosis

ORace

[OFReferring Physician
ORisk Stratification

[ Secondary Diagnosis
[ Sessions Cormpleted

O Sex |

Insurance Providers
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Only patients cowered by this insurance provider will be included in the report. This allows you to create
a report that you can show to the insurance providers themselves that will demonstrate the impact your
rehabilitation program has had on the health of their clients.

Maintenance Program

Choices are Inwlved or Not Involved. If Involved is chosen, only patients who are participating in a phase
3 or 4 program will be included in the report.

Onset to Entry Interval

Allows you to filter the patients to only include those that have a specific number of days between the
onset date and when the patient enters rehabilitation. The calculation uses the onset date in the patient
profile and the testing date of the patient’s pre program phase. Patients must have both of these value
entered to be included if this filter is on. The purpose of this filter is to correlate delays in beginning
rehabilitation with lower outcomes performance.

Primary Diagnosis

Only patients with the selected diagnosis will be included in the report. Currently, there is no way to
filter reports based on the secondary diagnosis as well.

Referring Physician

Only patients referred by this physician will be included in the report. This allows you to create a report
that you can show to the physicians themselves that will demonstrate the impact your rehabilitation
program has had on the health of their patients.

Rehabilitation Program

In the Multi-Program Edition of this software, you have the ability to choose which rehabilitation program
you would like to base the report on.

Risk Stratification
Choices are Low, Medium, and High.
Sex

Choices are Male or Female.
Benchmarking Reports

Understanding Your Benchmarking Reports

On page 1 or the cover of the benchmarking report, you will see the report title. The report title will read
either Standard or Premium Benchmarking Report. The Premium Benchmarking Report is a complete
comparison of your program to all programs in your state (area) and throughout the nation who are
reporting outcomes to Orion Software Development. Just below the title you will see the date range this
benchmarking report cowvers.

(Premium only) Page 2 of the premium benchmarking report provides a color graphical representation of
your program’s national percentile rank for each of the measured outcomes. The color-coded numerical
national percentile rank can be found in the table on the last few pages of the report in last column
(right). The columns in the graph are ordered as listed in the table at the end of the report. Programs that
perform at the 90th percentile provide the benchmark for best practices. Your program’s average
percentile rank can be viewed just below the report title "National Percentile Summary".

The remaining pages of the report provide you with a comparison of measured average (mean) change
between pre and post program for the outcomes measured in your program. To the far left you will see
the list of outcomes measured. Outcomes are listed below the domain (Behavioral, Clinical, Economic,
and Health) to which they are associated. Moving across the page to the right is the units of measure for
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each outcome. Most of these units are self-explanatory. If you see (1-5), this tells you that the outcome
is measured on a scale of 1 to 5. "NBS" is the abbreviation for Norm Based Scoring. In this system of
scoring, 50 is the norm. Scores above 50 are better and score below 50 are not as good.

Column one is "Your Program" data. This is the same data that you could generate yourself using the
Program Change Summary report at your site. The number in the "n" column indicates the number of
patients with data in both the pre-test and the post-test for this outcome. The "Awg" column is the
average (mean) change in the units of measure for this outcome. Between program change in outcomes
should never be compared using percentage (relative) of change. The change number may be positive or
negative. You must interpret whether positive or negative change is good for each particular outcome.
For example, the distance walked in the 6MDW should be positive if fithess improves but negative
change in weight is associated with good program performance.

The second and third column sections read the same. Column section two is data from the state or area
and column section three is national data. The number under "Count" indicates the number of programs
reporting pre and post data for this outcome. The "Avg" column is the average (mean) change in the
units of measure for this outcome in the state (area) or nation. The standard deviation ("StDeV') is listed
next and is a statistical measure of variability. Moving across to the right is the "Hi" (maximum) and the
"Low" (minimum). These two numbers form the range of change among programs in the state (area) or
nation. While this gives you a visual representation of the variability in the measured change, it should be
noted that the "Hi" and the "Low" are considered statistical outliers and are often the result of low
sample size, poor test administration, or data entry errors. If your program "Avg." represents a "Hi" or a
"Low", you may want to contact Orion Software Development for assistance.
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Protecting Your Data

Database Location

When Orion Outcomes was run for the first time, the user was given the choice of where to store the
database. The location might be on your computer’s hard drive or possibly on a network file server.

To determine the location of the database file currently in use, select the File menu and choose
Properties. The database location as well as the number of patients will be displayed.

Backing Up Your Data

In order to protect the patient data that you have entered in the system, it is highly recommended that
you make frequent backups.

To backup your data, go to the File menu. Choose Maintenance then Backup Database. You will be
given the option of where you want to save the database to. It contains all of your patient information and
outcome data. You must make a copy of this file to a safe place.

Restoring Your Data

If you happened to lose your Orion Outcomes patient data due to a hardware malfunction and you have
made a recent backup copy, you can recover your work up until the point when you made your last
backup.

To restore your data, close all programs. Place the backup copy of your file into the Orion Outcomes
installation directory. This is the only step necessary to restore your data.

Transfer to Another Computer

Occasionally, one might want to move Orion Outcomes software from one computer to another. For
example, this could be because you received a new computer.

Install Orion Outcomes on the new computer using your same serial number. We recommend that you
do not use your original CD-ROM. Instead, visit our web site to download the latest version of the
software at:

http://orionoutcomes.com/support/downloads/
Do not start the program once you hawe it installed.

On your old computer, from within Orion Outcomes, go to the menu bar and choose File -> Maintenance
-> Backup Database. Sawe the database in a location that you can access from both computers, such
as a floppy diskette or a shared network drive.

Run Orion Outcomes on the new computer. You will be prompted to create a new database or open an
existing one. Choose open existing and then select the file you backed up in the last step.

If you encounter a license compliance warning, contact Orion for further instructions.

Uninstall Orion Outcomes on the old computer. This can be done by opening the Windows Control Panel
and clicking on Add/Remove Programs.

Audit Trail

Audit trails are lists of activities and events that are performed by users and tracked on a per user basis.
The following events are listed in the audit trail:

¢ Adding a patient
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¢ Modifying a patient data item
¢ Deleting a patient
¢ Importing a patient data item
e Exporting data for benchmarking
The user that performs the action as well as the time of the action is recorded.

Inactivity Timeout

HIPAA requires computer systems to have an inactivity timeout. This prevents unauthorized access to
patient health information when users leave the computer terminal.

To change the number of minutes in the inactivity timeout, follow these steps:
1. Login to Orion Outcomes with the Administrator account.
2. Select the Tools menu and then Options.
3. Select the security tab.
4. Enter the number of minutes desired.

User Authentication
Logging In

HIPAA requires that all access to patient health information be audited. In order to track which
employees view which patient's records, audit trails must be kept on a per user basis. Auditing requires
users to login to use Orion Outcomes so that they can be identified. If all employees use a common
login, you will not be able to fulfill the auditing requirement of HIPAA.

To enable login capabilities with Orion Outcomes, you must set a password for the Administrator
account. If the Administrator account password is set to blank (nothing), then the login mechanism will
be disabled.

Administrator Account

The Administrator is the only pre-defined user account within Orion Outcomes. It cannot be deleted. The
Administrator account is used to administer the software and should not be used for day to day
operations, such as data entry.

The Administrator has special capabilities when logged in, such as:
¢ Ability to set the inactivity timeout value.
o Ability to create, edit or delete user accounts.

Adding a New User

To add a new user to Orion Outcomes, follow these steps:
1. Login to Orion Outcomes with the Administrator account.
2. Select the Lists menu and then User Accounts. The window shown below will appear.
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8] List of Users !EIE

Drag a column header here to group by that calumn,

Username # Active Passwiord

3
I

=| | Adrninistr atar [Hidden]

[Hidden]

3
I

KXl

=|| Brandon

3. On the toolbar, just below the File menu, press the New Record button. The window shown below

will appear.
r. — |
EEl User X
New User
Username: |Bran|:||:un
Passwiord; |****

Re-enter Passward: I****

Zancel

4. Fill out the information. The password must be entered twice. Press OK to complete the
operation.

7.74 Deleting a User

To delete a user from Orion Outcomes, follow these steps:
1. Login to Orion Outcomes with the Administrator account.
2. Select the Lists menu and then User Accounts. The window shown below will appear.
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List of Users u@ﬁ‘

Drag a column header here to group by that calumn,

sername / Active Passwiord

L]
2| Adrministr ator [Hidder)
2s| Brandon [Hidden)

3. Select the row containing the user you wish to delete.

4. Press the X button (directly to the right of the New Record button) on the toolbar.
Audit records pertaining to this user’s activity will not be deleted.
You cannot delete the Administrator account.

7.7.5 Changing Your Password

To change your password in Orion Outcomes, follow these steps:
1. Login to Orion Outcomes.
2. Select the Tools menu and then Change Password.
3. Enter your new password in both fields.

7.7.6 Forgot Your Password

If you forget your password, you should contact the person at your company that knows the
Administrator password for Orion Outcomes. This user can login as the Administrator and change your
user password to a new value.

If you have forgotten the password for the Administrator account, then you are stuck. Contact Orion
Software Development’s technical support to receive instructions on how to gain access.
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Sharing Your Data

Exporting
HIPAA

Using the Final Rules of the Health Insurance Portability and Accountability Act (HIPAA) as guidelines,
Orion Software Development adheres to the industry best practices for the privacy and security of
protected health information. Orion Software Development is committed to continue providing and
supporting a low-cost outcomes solution in light of this new legislation with its current support plan.

The HIPAA privacy regulations address what information is considered to be protected health information
(PHI). In supporting the product, Orion Software Development may come into contact with PHI. Orion
Software Development’s internal policies and procedures have been updated to address HIPAA
guidelines.

The following list contains features we will implement to safeguard health information and access to our
software products:
User Authentication

¢ |dentity verification for each session: unique user ID’s and passwords
¢ Automatic system time out after period of inactivity

Auditing
¢ Record access to patient information, including read-only access, additions, maodifications or
deletions to electronic information
Security
e Encrypted database system
Code Sets
¢ None of the required code sets are applicable
Transaction Standards
¢ None of the covered transactions are applicable
Privacy of PHI

¢ The software gives the option while preparing to benchmark to remove confidential patient
information from the export package. The following information can be removed from the database:
First Name, Last Name, Address, E-mail, Phone Number, Work Number, Nickname, Social
Security Number, Medical Record Number, and Account Number.

¢ A unique identifier is assigned to each patient when originally created. This identifier is used
internally during the synchronization process at the benchmarking site.

Benchmarking outcomes is a part of the continuous quality improvement process, which falls under
hospital operations. As such a patient release form is not necessary under HIPAA guidelines. It is
recommended that you indicate in your informed consent that PHI will be used for outcomes and
benchmarking purposes.

For compliance with HIPAA, you must choose one of the following options when submitting your data for
benchmarking. Limited is the suggested method.
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Method

PHI Included

PHI Excluded

Requirements

De-identified Data
Set

None

Name - First, Middle,
Last, Nickname

Address - Street, City,
Zip Code (State is
sent)

E-mail

Phone Number - Home
& Work

Social Security
Number

Medical Record
Number

Account Number

Birth Date (except
year)

Onset Date (except
year)

Testing Dates (except
year)

Treadmill Testing
Dates (except year)

No legal agreement
required.

Limited Data Set

City

State

Birth Date
Onset Date
Testing Dates

Treadmill Testing
Dates

Name - First, Middle,
Last, Nickname

Address - Street only
(City, State and Zip
Code are sent)

E-mail

Phone Number - Home
& Work

Social Security
Number

Medical Record
Number

Account Number

Requires a Data Use
Agreement between
Orion and your
program/hospital.

Full Data Set All None Requires a Business
Associate Agreement
between Orion and
your program/hospital.

Exporting Your Data

The main purpose of exporting your data is to share the data with other organizations that are running
this same software. By sharing this data, your community can begin aggregating the outcome data to

create sets of comparison data for benchmarking.
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To export your data, go to the Navigator. Select the File menu from the menu bar and choose the Import
and Export option. Then select the option Exporting outcome data for benchmarking.

Confidentiality
You will have a choice of whether or not you wish to send the patients confidential information along with
their outcome data. An internal identification number will substitute for the ID of the patient.

You will have the option of presening patient confidentiality by not sending the patient confidential
information in the export package, such as:

o First Name

e Last Name

e Address

e E-mail

e Phone Number

e Work Number

¢ Nickname

e Social Security Number
¢ Medical Record Number
e Account Number

Security

After encrypting the exported data package, it is secured with a password that can only be given by the
importing software. This necessary precaution is taken to prevent unauthorized access to the data
during the transfer.

Mode of Transfer

You will have the following choices for the mode of transfer after exporting your data:

e On Diskette: The process will create a set of 3.5" floppy disks that you will mail to Orion Software
Development. The contents of the floppy disks will be erased in order to make room for the data.
The export process assumes that your 3.5" floppy drive is labeled as drive A. If it is not, you may
go to the Options window and change the setting to the appropriate drive.

¢ Over the Internet: You must be connected to the Internet to use this feature. Your data will be
exported over the Internet to the Orion Software Development. The export uses a Secure File
Transfer Protocol (SFTP) to send the data. If you are having trouble with Internet exports, it is
usually because your IS/IT department has a firewall or other security device blocking your
transfer. Orion Outcomes uses Secure File Transfer Protocol (SFTP) to transfer the benchmarking
data. SFTP uses port 22 to connect to orionoutcomes.com. Depending on your firewall, there are
a variety of options for configuring this method. This will need to be done by your IT/IS department.
There is nothing in Orion Outcomes that you can change to make it work in this case.
Some companies have a proxy server installed that you need to configure Orion Outcomes to
work with. You will need to get the proxy server information from your IS/IT department or have
them do the configuration for you. The proxy configuration screen is in Orion Outcomes under the
Tools->Option menu on the Export tab.

Importing
Importing Data

The Import and Export Wizard is the sole mechanism that allows data to be easily moved in and out of
Orion Outcomes. You may import data from a variety of sources:

¢ Importing From Previous Version
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¢ Importing From Another Site
3rd Party Software
We hawve collaborated with other product vendors to integrate Orion Outcomes into their existing software
solutions. The following is a list of products that are capable of sharing data with this product:

¢ Quinton Q-Tel

e LS| TrensCenter

e ScottCare TeleRehab System

Importing From Another Site

This option is only available if you have purchased the Multi-Program Edition of Orion Outcomes from
Orion Software Development. To import the data, follow these steps:

1. From the Navigator, select File on the menu bar and choose the Export and Import option.

2. Inside the Import and Export Wizard, select the Import data that was exported from another site
option.

3. Insert the first disk of the exported data set into your floppy drive.

4. Follow the instructions on the screen.

Importing From Previous Version

The Import and Export Wizard will help you to extract data that you collected while using a previous
version of the Orion Outcomes and bring it into the more current version. To import your data, follow
these steps:

1. From the Navigator, select File on the menu bar and choose the Export and Import option.
2. Inside the Import and Export Wizard, select the Import data from a previous version option.

3. You will need to locate a previous copy of your database, which contains all of your older data.
This file is usually called Outcomes.mdb or odmsdt.mdb.

4. Follow the instructions on the screen.
LSI TrensCenter

To export data from the LS| TrensCenter, see the documentation provided by LSI.
To import the data into Orion Outcomes, follow these steps:
1. From the Navigator, select File from the menu bar and choose the Export and Import option.
2. Inside the Import and Export Wizard, select the LS| TrensCenter option.
3. You will be asked to locate the OUTCOME.TXT file that you created in step 7 above.
4. The action will be performed once you press the Finish button.

NOTE: Any data importing problems found during this procedure will be logged into the file Import Log.
txt that can be found in the Orion Outcomes installation directory. You can access this file from within
Orion Outcomes from the Help->Troubleshooting menu. You will be notified if errors were logged.

Quinton Q-Tel

To export data from the Q-Tel system, see the documentation provided by Quinton.

To import the data into Orion Outcomes, follow these steps:
1. From the Navigator, select File from the menu bar and choose the Export and Import option.
2. Inside the Import and Export Wizard, select the Quinton Q-Tel option.
3. The action will be performed once you press the Finish button.
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NOTE: Any data importing problems found during this procedure will be logged into the file Import Log.
txt that can be found in the Orion Outcomes installation directory. You will be notified if errors were
logged.

ScottCare TeleRehab

To export the data from the TeleRehab System, follow these steps:
1. Select the report form while running TeleRehab.
. Enter the information into the report form using TeleRehab.
. Repeat steps 1 and 2 until all information on the patient has been completed.
. Run the TeleRehab Export Program (TREXPORT.EXE).
. Select the export option ODMS from the export options dialog box.
. Select the EXPORT function then select patient directory(s) to export.

. If TREXPORT.EXE has enough information to proceed with the export and can find the session
files needed for export, one Orion Outcomes export file will be written out with a filename of
TELERHAB.CSV

To import the data into Orion Outcomes, follow these steps:
1. From the Navigator, select File from the menu bar and choose the Export and Import option.
2. Inside the Import and Export Wizard, select the ScottCare Tele-Rehab System option.
3. You will be asked to locate the TELERHAB.CSYV file that you created in step 7 above.
4. The action will be performed once you press the Finish button.

NOTE: Any data importing problems found during this procedure will be logged into the file Import Log.
txt that can be found in Orion Outcomes installation directory. You will be notified if errors were logged.
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Troubleshooting

Updating Your Software

Orion Software Development makes available free senice releases of Orion Outcomes from our web site.
Before reporting a problem, be sure that you are running the latest Orion Outcomes senvice release.

Seniice releases can be downloaded from within Orion Outcomes by going to the Help menu and
choosing Check for Software Updates.

If a newer version is available, you will be able to download and install it. If the computer that Orion
Outcomes is installed on does not have Internet access, you may either:

¢ Download the senvice release on to a computer with Internet access and then transfer the file to
the computer with Orion Outcomes on it.

¢ Purchase a replacement CD-ROM from Orion Software Development's web site for a nominal fee.
Event Log

As users perform actions within Orion Outcomes, an event log is captured in order to help with
troubleshooting. Orion Software Development will often ask for this log file when troubleshooting a
complex issue.

You may also find information that may be of help when troubleshooting your own issues by viewing the
event log.

To access the event log, follow these steps:

1. Select the Help menu, then Troubleshooting, then View Event Log.

2. An associated document viewing program, such as Notepad, will display the event log contents.
This file may be saved and submitted to Orion Software Development if requested.

Contacting Technical Support

For technical support on this product, contact Orion Software Development via:
e E-mail: support@orionoutcomes.com

Internet:  http://orionoutcomes.com/

Phone:  (720) 494-7950

e Fax: (720) 494-7951
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End User License Agreement

End User License Agreement

IMPORTANT -- READ CAREFULLY: This Orion Software Development End User License
Agreement (EULA) is a legal agreement between you (either an individual or a single entity)
and Orion Software Development for the Orion Software Development software product
identified above, which includes computer software and associated media and printed
materials, and may include online or electronic documentation (SOFTWARE PRODUCT or
SOFTWARE). By installing, copying, or otherwise using the SOFTWARE PRODUCT, you agree
to be bound by the terms of this EULA. If you do not agree to the terms of this EULA, promptly
return the unused SOFTWARE PRODUCT to the place from which you obtained it for a full
refund.

SOFTWARE PRODUCT LICENSE

The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well
as other intellectual property laws and treaties. The SOFTWARE PRODUCT is licensed, not sold.

1. GRANT OF LICENSE. This EULA grants you the following right(s) provided that you comply with
all the terms and conditions of this EULA:

e Installation and Use. You may install and use one copy of the SOFTWARE PRODUCT on
one personal computer or other device.

2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS.

e Limitations on Reverse Engineering, Decompilation, and Disassembly. You may not
reverse engineer, decompile, or disassemble the SOFTWARE PRODUCT, except and only to
the extent that such activity is expressly permitted by applicable law notwithstanding this
limitation.

e Separation of Components. The SOFTWARE PRODUCT is licensed as a single product.
Its component parts may not be separated for use on more than one computer.

¢ Rental. You may not rent or lease the SOFTWARE PRODUCT.

e Support Services. Orion Software Development may provide you with support senices
related to the SOFTWARE PRODUCT ("Support Senices"). Any supplemental software code
provided to you as part of the Support Senices shall be considered part of the SOFTWARE
PRODUCT and subject to the terms and conditions of this EULA. With respect to technical
information you provide to Orion Software Development as part of the Support Senices, Orion
Software Development may use such information for its business purposes, including for
product support and development. Orion Software Development will not utilize such technical
information in a form that personally identifies you.

o Software Transfer. You may permanently transfer all of your rights under this EULA,
provided you retain no copies, you transfer all of the SOFTWARE PRODUCT (including all
component parts, the media and printed materials, any upgrades, and this EULA), and the
recipient agrees to the terms of this EULA. If the SOFTWARE PRODUCT is an upgrade, any
transfer must include all prior versions of the SOFTWARE PRODUCT.

¢ Termination. Without prejudice to any other rights, Orion Software Development may
terminate this EULA if you fail to comply with the terms and conditions of this EULA. In such
event, you must destroy all copies of the SOFTWARE PRODUCT and all of its component
parts.

3. UPGRADES. If the SOFTWARE PRODUCT is an upgrade from another product, whether from
Orion Software Development or another supplier, you may use or transfer the SOFTWARE
PRODUCT only in conjunction with that upgraded product, unless you destroy the upgraded
product. If the SOFTWARE PRODUCT is an upgrade of a Orion Software Development product,
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you now may use that upgraded product only in accordance with this EULA. If the SOFTWARE
PRODUCT is an upgrade of a component of a package of software programs that you licensed as
a single product, the SOFTWARE PRODUCT may be used and transferred only as part of that
single product package and may not be separated for use on more than one computer.

4. COPYRIGHT. All title and copyrights in and to the SOFTWARE PRODUCT (including but not
limited to any images, photographs, animations, video, audio, music, and text incorporated into
the SOFTWARE PRODUCT), the accompanying printed materials, and any copies of the
SOFTWARE PRODUCT are owned by Orion Software Development or its suppliers. The
SOFTWARE PRODUCT is protected by copyright laws and international treaty provisions.
Therefore, you must treat the SOFTWARE PRODUCT like any other copyrighted material except
that you may make one copy of the SOFTWARE PRODUCT solely for backup or archival
purposes. You may not copy the printed materials accompanying the SOFTWARE PRODUCT.

5. DUAL-MEDIA SOFTWARE. You may receive the SOFTWARE PRODUCT in more than one
medium. Regardless of the type or size of medium you receive, you may use only one medium
that is appropriate for your single computer. You may not use or install the other medium on
another computer. You may not loan, rent, lease, or otherwise transfer the other medium to
another user, except as part of the permanent transfer (as provided abowe) of the SOFTWARE
PRODUCT.

6. U.S. GOVERNMENT RESTRICTED RIGHTS. The SOFTWARE PRODUCT and documentation
are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is
subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and
Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the
Commercial Computer Software—Restricted Rights at 48 CFR 52.227-19, as applicable.
Manufacturer is Orion Software Development/11691 Montgomery Circle/Longmont CO 80504.

LIMITED WARRANTY. Orion Software Development warrants that (a) the SOFTWARE PRODUCT wiill
perform substantially in accordance with the accompanying written materials for a period of ninety (90)
days from the date of receipt, and (b) any Support Senices provided by Orion Software Development
shall be substantially as described in applicable written materials provided to you by Orion Software
Development, and Orion Software Development support engineers will make commercially reasonable
efforts to solve any problem issues. Some states and jurisdictions do not allow limitations on duration of
an implied warranty, so the above limitation may not apply to you. To the extent allowed by applicable
law, implied warranties on the SOFTWARE PRODUCT, if any, are limited to ninety (90) days.

CUSTOMER REMEDIES. Orion Software Development’s and its suppliers' entire liability and your
exclusive remedy shall be, at Orion Software Development's option, either (a) return of the price paid, if
any, or (b) repair or replacement of the SOFTWARE PRODUCT that does not meet Orion Software
Dewelopment's Limited Warranty and which is returned to Orion Software Development with a copy of
your receipt. This Limited Warranty is void if failure of the SOFTWARE PRODUCT has resulted from
accident, abuse, or misapplication. Any replacement SOFTWARE PRODUCT will be warranted for the
remainder of the original warranty period or thirty (30) days, whichever is longer.

NO OTHER WARRANTIES. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW,
ORION SOFTWARE DEVELOPMENT AND ITS SUPPLIERS DISCLAIM ALL OTHER WARRANTIES
AND CONDITIONS, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, IMPLIED
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE, AND
NON-INFRINGEMENT, WITH REGARD TO THE SOFTWARE PRODUCT, AND THE PROVISION OF
OR FAILURE TO PROVIDE SUPPORT SERVICES. THIS LIMITED WARRANTY GIVES YOU
SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHERS, WHICH VARY FROM STATE/JURISDICTION
TO STATE/JURISDICTION.

LIMITATION OF LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO
EVENT SHALL ORION SOFTWARE DEVELOPMENT OR ITS SUPPLIERS BE LIABLE FOR ANY
SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING,
WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS
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INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER PECUNIARY LOSS)
ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE PRODUCT OR THE
PROVISION OF OR FAILURE TO PROVIDE SUPPORT SERVICES, EVEN IF ORION SOFTWARE
DEVELOPMENT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE,
ORION SOFTWARE DEVELOPEMENT'S ENTIRE LIABILITY UNDER ANY PROVISION OF THIS
EULA SHALL BE LIMITED TO THE GREATER OF THE AMOUNT ACTUALLY PAID BY YOU FOR
THE SOFTWARE PRODUCT OR U.S.$5.00; PROVIDED, BECAUSE SOME STATES AND
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY, THE ABOVE
LIMITATION MAY NOT APPLY TO YOU.
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